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Notice

While reasonable efforts were made to ensure that the information in this document was complete and accurate at the time of
printing, Avaya Inc. can assume no liability for any errors. Changes and corrections to the information in this document may be
incorporated in future releases.

Documentation Disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to the original published version of this
documentation unless such modifications, additions, or deletions were performed by Avaya.

Link Disclaimer

Avaya Inc. is not responsible for the contents or reliability of any linked Web sites referenced elsewhere within this
Documentation, and Avaya does not necessarily endorse the products, services, or information described or offered within
them. We cannot guarantee that these links will work all of the time and we have no control over the availability of the linked
pages.

License

USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER’S ACCEPTANCE OF THE TERMS SET FORTH
HEREIN AND THE GENERAL LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE AT
http://support.avaya.com/Licenselnfo/ (“GENERAL LICENSE TERMS”). IF YOU DO NOT WISH TO BE BOUND BY THESE
TERMS, YOU MUST RETURN THE PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN (10) DAYS OF DELIVERY
FOR A REFUND OR CREDIT.

Avaya grants End User a license within the scope of the license types described below. The applicable number of licenses and
units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is
specified in the Documentation or other materials available to End User. “Designated Processor’” means a single stand-alone
computing device. “Server” means a Designated Processor that hosts a software application to be accessed by multiple users.
“Software” means the computer programs in object code, originally licensed by Avaya and ultimately utilized by End User,
whether as stand-alone Products or pre-installed on Hardware. “Hardware” means the standard hardware Products, originally
sold by Avaya and ultimately utilized by End User.

License Type(s): Designated System(s) License (DS).

End User may install and use each copy of the Software on only one Designated Processor, unless a different number of
Designated Processors is indicated in the Documentation or other materials available to End User. Avaya may require the
Designated Processor(s) to be identified by type, serial number, feature key, location or other specific designation, or to be
provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Copyright

Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting proprietary rights.
Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense under the applicable law.

Third-Party Components

Certain software programs or portions thereof included in the Product may contain software distributed under third party
agreements (“Third Party Components”), which may contain terms that expand or limit rights to use certain portions of the
Product (“Third Party Terms”). Information identifying Third Party Components and the Third Party Terms that apply to them is
available on Avaya’'s web site at: http://support.avaya.com/ThirdPartyLicense/

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call Technical Service
Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. Suspected security
vulnerabilities with Avaya Products should be reported to Avaya by sending mail to: securityalerts@avaya.com.

For additional support telephone numbers, see the Avaya Support web site (http://www.avaya.com/support).

Trademarks

Avaya and the Avaya logo are registered trademarks of Avaya Inc. in the United States of America and other jurisdictions.
Unless otherwise provided in this document, marks identified by “®,” “™” and “SM” are registered marks, trademarks and
service marks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

Documentation information
For the most current versions of documentation, go to the Avaya Support web site (http://www.avaya.com/support) or the IP
Office Knowledge Base (http://marketingtools.avaya.com/knowledgebase/).

Avaya Support

Avaya provides a telephone number for you to use to report problems or to ask questions about your contact center. The
support telephone number is 1 800 628 2888 in the United States. For additional support telephone numbers, see the Avaya
Web site: http://www.avaya.com/support.
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Introduction:

1. Introduction

The IP Office Softphone from Avaya enables you to make voice and video phone calls using SIP-based standards.

Standard Telephone Features
The Avaya IP Office Softphone has all standard telephone features, including:

e Call display and Message Waiting Indicator (MWI)

e Speakerphone and Mute

e Redial, Hold, Do Not Disturb

e Call history - list of received, missed, and dialed calls
e Access to IP Office directory

¢ Call forward

o Call transfer

e Six-party audio conferencing

e Six-party video conferencing

Enhanced Features and Functions
The IP Office Softphone also supports the following features and functions:

e Video

e Support for several languages in addition to English: French, German, Italian, Portuguese, and Spanish.
e Contact list containing the individual user’s contacts

o Directory containing names from central and personal IP Office directory

e Automatic detection and configuration of audio and video devices

e Acoustic echo cancellation, automatic gain control, voice activity detection

e Support for DTMF (RFC 2833, inband DTMF or SIP INFO messages).

e Support for the following audio codecs: G.711, G.723.1, G.729a, G.722

e Support for the following video codecs: H.263, H.263+, H.264

e Compliance to 3261 SIP standard

e Support for these firewall traversal solutions: STUN, TURN, or ICE

e The IP Office Softphone includes an icon to indicate your do not disturb status. The icon can be clicked to change

the status

e A Speed Dials tab is available. It contains buttons to which you can assign numbers to dial and name labels. For

buttons that match another extension number, the button color indicates when that user is busy

1.1 IP Office Application mode

For users of IP Office productivity applications such as one-X Portal for IP Office, IP Office Softphone can be used with

the application.

For all standard calls, with IP Office Softphone minimized to the system tray, the user can answer, make and terminate
calls using the one-X Portal for IP Office. All the one-X Portal for IP Office features like centralized call log and busy lamp

are available to the user. A user can pre-select to accept audio calls or select calls as Video calls when receiving and

making calls from an application like one-X Portal for IP Office.

This mode is not covered in detail in this manual, please refer to the user manual of the productivity application like

one-X Portal for IP Office.

IP Office Softphone
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1.2 Getting Ready

SIP Account Information
You will need the following information:

e User name and password

e Login Server (IP Office)

If you have not been provided this data, please contact your IP Office administrator for the details.

System Requirements

Processor e Minimum: Pentium 4 2.4 GHz or equivalent.
e Optimal: Intel Core 2 Duo or equivalent, Video Card with DirectX 9.0c
support.
Memory e Minimum: 1 GB RAM

e Optimal: 2 GB RAM

Hard Disk Space

50 MB

Operating System

Microsoft Windows XP Service Pack 2
Microsoft Windows Vista, 32-bit and 64-bit arch

Microsoft Windows 7

Additional

Microsoft .NET Framework 4
Microsoft Visual C++ 2008 SP1
Microsoft KB967634 Hotfix

Note that the installer will take care of installing those if you do not have
them.

Connection

IP network connection (broadband, LAN, wireless)

Sound Card

Full-duplex, 16-bit or use USB headset

Browser Support

Microsoft Internet Explorer 6.0 or later

Multimedia Device Requirements

The IP Office Softphone requires both speakers and a microphone to make calls. Any of the following configurations are

acceptable:

e External speakers and microphone

e Built-in speakers and microphone

e Dual-jack multimedia headset

e USB multimedia headset

e USB phone.

HID-compliant devices can be configured to work with the IP Office Softphone to support e.g. hook-switch functionality.

Video Cameras

Calls made with the IP Office Softphone will work without a video camera, but a video camera is necessary to allow other

parties to see your image. The IP Office Softphone will work with most USB video cameras.

IP Office Softphone
IP Office
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Introduction: Installing IP Office Softphone

1.3 Installing IP Office Softphone

Run the IP Office Softphone installer and follow the prompts in the install wizard.
To start the softphone, select Launch the IP Office Softphone when the installation is complete.

J

Alternatively, use the Windows Start menu or double-click the IP Office Softphone desktop icon: Ld

1.4 |IP Office Softphone Login

The Softphone Login window appears once the IP Office Softphone has been started.

s =Y

Profile: [lz Office: Default v |
Login server: | 192.168.0.210 ;|
Username [; Extn203 :l
Password: |'f Ty -\'l

N A

@ Remember login information

|:| Minimize to System Tray

1. Enter your user name, password and login server into the corresponding fields.

S —

2.Select the bandwidth profile for your network.
e Use the standard setting Default to let IP Office select the best available transmission rate.
e Select Low Bandwidth if you are working at a location where bandwidth is limited.

e Selected High Bandwidth only if you are sure that you are connected to a network with no bandwidth
limitation.

3.1If you are the only person who uses the PC, you can use the Remember login information setting to have IP
Office Softphone remember the name and password.

4. Selecting the Login automatically option will allow you to skip the login process the next time you start the IP
Office Softphone. The logging in process is still displayed for a few seconds in order to allow you to interrupt it if
necessary.

5.Minimize to System Tray will do just that after the login has been completed successfully. Use this option if you
don't immediately intend to use IP Office Softphone but want it running and available.

6.Click Log in. The progress of the login is displayed and details of which audio devices the IP Office Softphone is
using are also shown.

Hot Desking with IP Office Softphone
If you normally work from a phone on the IP Office telephone system or are temporarily logged in at one, logging in to IP
Office Softphone will automatically log you off that phone and redirect your calls to your IP Office Softphone.

1.5 Troubleshooting

The IP Office Softphone includes three tools for helping you troubleshoot problems:

e You can verify that your microphone, speakers and camera are working and can set the volume to a comfortable
level without having to actually place a phone call.

e You can verify that you are successfully connected to the network.

e While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should
be on an established call (not a call attempt).
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Note: Audio quality is dependent on several parameters that IP Office Softphone can not completely influence. When
troubleshooting, please also take those parameters into account:

A.Network quality:

a. If audio problems occur, try to select the "Low Bandwidth" setting when logging into the IP Office Softphone.
The softphone will then use bandwidth efficient transmission of audio streams.

b.If using Video, select a lower video resolution in Softphone > Preferences > Media Quality tab. Also, try
to use the H.264 Codec instead of H.263 if possible (for settings please see Media Quality[ 38" and Video
Codecs[3™)

c. Refrain from using video

B.Competing processes and resources
While every possible attempt has been taken to give IP Office Softphone priority over other applications, there is a
chance that those applications, e.g. Virus scan software, can impact performance from the softphone, The
following actions can be taken.

a. Close unused applications to e.g. avoid memory swapping
b. Postpone activities like virus scans to a time when IP Office Softphone is not needed
c. Use a single screen PC, not dual monitor if possible.

d. Parallel usage of other communication tools, like e.g. NetMeeting for application sharing can impact
voice-quality, especially if used with a low-bandwidth network. If audio quality issues appear, refrain from
using other communication applications

Known Issue

If you select menus or click on contacts and the dropdown/pullout menu is not visible (it appears behind the main
Softphone panel instead of in front of it), do not be concerned. Softphone itself is not experiencing a problem. This is
known to occur with lower-end graphics chipsets and outdated graphics drivers. Updating your drivers and/or upgrading
to Windows 7 should resolve this problem completely. The only workaround for this issue is to reboot the PC.
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Chapter 2.

Using the IP Office Video
Softphone
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2. Using the IP Office Video Softphone
2.1 Starting the IP Office Softphone

If the IP Office Softphone is not already running, start it as you would any other program: Use the Windows Start menu
or double-click the desktop icon. The IP Office Softphone appears.

IP Office Softphone can be set to start automatically when you start Windows. This is controlled through the IP Office
Softphone preferences| 34, which you can set on the Preferences > Application panel.

2.2 Shutting Down

To shut down the IP Office Softphone, either select Softphone > Exit or press Ctrl-Q. You can also right-click on the
tray icon and select Exit to shut down the IP Office Softphone.

¢ Note that clicking the “ icon on the softphone title bar minimizes the IP Office Softphone to the system tray; it
does not exit the IP Office Softphone

2.3 The IP Office Softphone Windows

You can arrange the IP Office Softphone window to suit your needs, showing or hiding many of the controls.

Sofiphone  View Contacis Help

IQ Available ¥ e
I d 1§ &6 X§ %
( -'-) [[can

[t 2o 3]

|Gr~ 4“‘__-; 5.|_wo 6.|

|PQ'1§ ?|7._,v 8 || vorvz 9.

[~ o #
(g () () (=) (=9 (8

Conf Redial Spkr Hod Transfer End

e @ W

Contacts | Hisiory Directory Featwes Speed dia

& ( 13

¥ Broadcast Groups (1) FJ
. 2\ @ everyone
@ U
¥ Family (0}
¥ Friends (0)

w system (93)

e

“Q Bobd16

[ [l

[ Ll

B b &
. AVAVA

[’Iff’l
'm./ Online Status

This icon indicates your online status. For a list of status icons and their meanings, see Setting your status/ 25",

. @ / @ Allow Calls/Do Not Disturb
This icon, located on the right side of the panel, indicates whether you have do not disturb on or off. Clicking on
the icon makes a call to the IP Office phone system to change the current state. When you have do not disturb on

(@), calls to you are redirected to your voicemail if available, otherwise they receive busy.

. % Show/Hide the dial pad.
You can type numbers and names directly into the call entry field or you can show and use the on screen dial pad.

[6e) (o) (00 =) [=) (£
o (Conf Redisl Spkr  Hold Transfer End  In Call Control Buttons

These buttons appear below the dial pad when it is shown. To show or hide them select Softphone >
Preferences > Application > Display in-call buttons on the dialpad. By default, these buttons are hidden.
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Using the IP Office Video Softphone: The IP Office Softphone Windows

. ? Show/Hide video.
Click to show or hide the video window.

. Speaker/Headset mode.
Switch between headset and PC speaker modes.

o N Adjust speaker volume.

E

. Mute/Unmute microphone.

o]
e = Message waiting indicator.
Click to access your voicemail mailbox. You need the dialpad visible in order to drive the mailbox prompts.

& Missed call indicator.
Click this icon to open the History tab and view a list of missed calls.

¢ View Menu Options
The view menu provides the following options:

e Select which tabs to show
Show or hide the Contacts| 22, History! 27, Directory| 27, Features| 29 and Speed Dial| 30 tabs.

« [7 Bl petach/Reattach Tabs
When displayed, you can use these icons to select whether each tab appears as part of the main windows or
as a separately sizeable and positionable window.

e Always on Top
Set the IP Office Softphone to remain on top of other application windows.

e Zoom
Change the size of the text and controls used in the IP Office Softphone windows.

¢ Message Archive
View you recent IM activity for any contact, group chat session, or chat room session.

¢ Chat Rooms
View the chat rooms that you belong to.

. “ Minimize to the system tray
Run the IP Office Softphone as an icon in your Windows system tray (normally bottom right of your Windows
desktop). To reopen IP Office Softphone double click on that icon.

e While minimized to the system tray, you can use the popup alerts to handle incoming calls. Select Softphone
> Preferences > Alerts & Sounds > Enable alert displays to switch alerts on or off.

e Alternatively minimize the IP Office Softphone to the system tray if you want to use another IP Office
application such as the one-X Portal for IP Office to make and answer your calls.

o If you exit when the IP Office Softphone is minimized; the IP Office Softphone will start as minimized next
time.

. n Minimize to taskbar
Minimizes the IP Office Softphone to the Windows taskbar.

e Close the IP Office Softphone
To close the IP Office Softphone select Softphone > Exit. You can also right-click on the tray icon and select Exit
to close the IP Office Softphone.
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2.4 Placing a Call

The simplest method to make a call is to enter the name or number into the call entry field. As you enter the name or
number, matches from your Contacts and History are shown and can be selected to complete the name or number.

Click * to clear the entry or Call to make the call.

You can also click on the = down arrow icon and select Audio Call or Video Call.

(Cail [v] |

Audio call

Wideo call

There are many ways in which you can select or enter a number and then make a call. They are outlined in the table
below. Once started, the outgoing call opens in its own panel within the main IP Office Softphone window. You will hear a
ringing tone while the IP Office Softphone attempts to make a connection.

From the... Description

Keying Dialpad or computer |1.Enter the number or address in the call entry field using the
keyboard dialpad or the computer keyboard.

e As you type, a suggestion for completing the entry may
appear. Choose the suggestion or keep typing.

2.Click the Call button or press Enter.

Drag-and-drop contact or |Contacts or History |Drag an entry from the Contacts or History tab. If the tab
previous call tab contains lots of contacts, first search or filter the list.

Right-click a contact or Contacts or History |Right-click an entry from the Contacts or History tab and choose
previous call tab Call.

If the tab contains lots of entries, first search or filter the list.

Double-click a contact Contacts tab Contacts have a "double-click" action that either makes an audio
phone call. Each contact can be configured separately for this
action.

Double-click a previous History tab Double-click an entry. An audio call is placed.

call

Redial Redial button e When the call entry field is empty, click the Call button. The last

number dialed is shown. Click Call again to call it.

e Or click the = down arrow in the call entry field and select a
recent call. The Softphone will redial the call immediately if you
have selected the option to "Call immediately when a number is
selected" in the Preferences > Application menu.

Dialing Dialpad 1.If the dialpad is not visible, click the Show/Hide dialpad
button.

2.Click the numbers on the dialpad to enter the phone number or
enter the number or address in the call entry field using the
dialpad or the computer keyboard.

3.Click the Call button or press Enter.

2.5 Placing Another Call

To place a new call without hanging up on the current call, simply place a calll 144 in the normal way. A second call panel
appear below the existing call and the existing call is automatically put on hold.

Switch between the different calls by clicking Resume on the desired call panel. That call becomes the active call and all
other calls are on hold.
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Using the IP Office Video Softphone: Ending a Call

2.6 Ending a Call

Click the End button on the call panel (the call can be active or on hold). The call panel closes after a few seconds.

2.7 Handling Incoming Calls

As soon as an incoming call is received, a call panel appears, showing information about the call. In addition, call alert
boxes appear even if IP Office Softphone is minimized.

You can disable the call alert box through the IP Office Softphone preferences| 34 available on the Preferences > Alerts
& Sounds panel.

Y Kokila
LW Kokl

|t.. Answer | l-l"'l Decline

Incoming call alert for audio
only.

P Kokila
LW K<okils

| @ Video | [ Audic | [#® Decline

Incoming call alert with video.

Action From the... Description

Answer Call panel or Call |Click Answer. Or press Enter (on the keyboard), if the IP Office Softphone is the
Alert box active application.

If you are on another call, that first call is automatically put on hold. You are now
talking to the new caller.

Forward |Features tab Select the Features tab to access the call forwarding feature. For information about
how to program a Feature button for call forwarding, see Features Tab! 29,

Decline Call panel or Call |Click Decline. There will be a busy signal.

Alert box
Video Call panel or Call |The caller wants to include video.
Alert box . . . . . .
Click to answer a video call and start sending your video immediately
Audio Call panel or Call |The caller wants to include video.
Alert box

Click to answer without video; if you want (and if you have a camera), you will be
able to add video later.

2.8 Auto Answer

To turn auto-answer off and on, in the call panel click # and select Auto Answer.

Auto answer is initially configured to auto-answer after one ring, and to send only your audio when the call is established.
To change this configuration choose Softphone > Preferences > Call Automation /3%,

Auto answer is automatically turned off when you shut down.
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2.9 Handling an Established Call

While the call is in progress details of the call are displayed in a call panel.
You can use the icons and buttons to control the call.

e Hold the Call: Click Hold. To take the call back off hold click Resume.

e Transfer the call: Click @

and select Start Call Recording.

e Add video: Click . To switch back to audio only click

-

¢ Record the call: Click
¢ End the Call: Click End.

2.10 Transfering a Call

Basic (Unattended) Transfer — Transfer this Call
You can transfer a call to any number without first speaking to the other person.

1. While connected to the call that you want to transfer, click on the '@ transfer icon.

2.The call is put on hold. Below the call details enter the name or number for the transfer destination.
3.Click on Transfer Now. A call is placed to the transfer destination.

4.To complete the transfer without waiting for the call to be answered click on End.

Attended Transfer — Call then Transfer
You can first speak to the target (the person you are transferring the call to).

1. While connected to the call that you want to transfer, click on the '@ transfer icon.
2.The call is put on hold. Below the call details enter the name or number for the transfer destination.
3.Click on Call. A call is placed to the transfer destination.

4.If the call is not answered or the transfer destination doesn't want the call, click Resume to return to the held call.
To complete the transfer click Transfer Now.

2.11 Handling Video Calls

Placing a Video Call
You can start a call with video. See the table.

From the... Description

Keying Dialpad or computer 1. Enter the number or address in the call entry field using the
keyboard dialpad or the computer keyboard

e As you type, a suggestion for completing the entry may
appear. Choose the suggestion or keep typing.

2.Click the = arrow beside the Call button and choose Video call.

Right-click a contact|Contacts or History tab |Right-click an entry from the Contacts or History tab and choose
or previous call Video Call.
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Using the IP Office Video Softphone: Handling Video Calls

Adding Video

If you have a camera, you can click Start Video to add video to an established call. When you add video, the other
party may (or may not) start sending their video to you.

Other Party Adds Video
If the other party starts their video, your video window automatically opens and the video is played. You can start

sending your own video, if desired (and assuming you have a camera) by clicking Start Video.

Pausing and Resuming Video

Click g*

Stop Video or close the video window to pause sending your video.

Click Start Video to resume sending your video; the video window will open.

Click y to show or hide your video window (this does not stop the video).

Grandstream Users
If you use Grandstream, or if the person with whom you wish to have a video call uses Grandstream, ensure that all
participants in the video call switch to video codec H.264. Participants who do not switch codecs will be able to send and

see their own video, but the intended recipient(s) will not see anything due to a codec negotiation error. See the section
on Video Codecs|3™ for more information.

2.12 Voicemall

You can click the X2 icon to automatically connect to voicemail and listen to your messages.

You will need to have the dialpad visible in order to move around the mailbox options. Click on the % Dialpad icon if
the dialpad is not already displayed.

2.13 Conference Calls

Starting a Conference Call
You can conference two separate calls together once both calls are established[ 14,

¢ In the current Call panel, click on * and select Merge Calls. Alternatively, you can click on the Ceonf button if it
is shown on the In Call Control Buttons panel. To display this button, refer to The IP Office Softphone Windows
[ 124 section of this document.

Video Conference Calls

Calls made with the IP Office softphone will work without a video camera, but a video camera is necessary to allow other
parties to see your image. The IP Office Softphone will work with most USB video cameras.

Ensure that all the participants you invite to the conference are sending video prior to merging their calls.

e Click on # and select Merge Calls, or click on the <Canf putton.

After the conference is established, participants may have to resend their video. When participants are removed from
hold or new participants join the conference, each participant must resend their video when the conference session
continues.

Including Video in a Conference

When you start a conference from established calls, video is automatically included if at least one of the calls already
includes video and is sent to all the participants.

When you start an audio conference from scratch, video is not included. Once you begin an audio conference, you cannot
change the conference into a video conference.
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How Video is Shared

The conference host (the person who starts the conference) serves as the host for other video. Whatever the conference
host is receiving will automatically be sent to the other parties. If the conference host pauses or stops video, the other
participants will no longer receive video. As such, in the event that you experience video errors, request that the
conference host reestablish video to all parties by disabling and re-enabling video.

2.14 Instant Messaging

You can send an Instant Message (IM) to a contact who has a softphone or XMPP address, but you must be connected to
one-X Portal. The IP Office Softphone allows you to send IMs to individuals or broadcast groups, and also supports IM
conferencing and chat rooms (including ad-hoc group chat). In addition, you can send files to any user who has an XMPP
address.

Sending an IM
1.From the Contacts tab, right-click on the contact and choose Send Instant Message. The contact must have a
softphone address. Alternately, click on the IM icon that appears to the right of the contact name.

2.Type the message, including any emoticons and formatting that you wish. To insert a return in the message, press
Enter. (You can control the behaviour of Enter and of Ctrl-Enter on the Softphone > Preferences > Application
panel.)

3.Click Send.

Note: If the status of the recipient is set to Do Not Disturb, the message will not be received.

Receiving an IM
When you receive an IM, either the IM window, or a Call Alert displays without opening the IM window. You can choose
which window displays using the Preferences > Alerts & Sounds > Alerts panel.

Sending a Broadcast IM
You can send an IM to several people at one time. A broadcast IM is different than a group chat:

e With a broadcast IM, each recipient can reply to the IM, but only the sender will see these replies; the other
recipients will not see these replies.

e With a group chat, the messages that each participant sends are seen by all participants.

1.Select the parties from the Contacts tab in one of the following ways:
e Select one or more contacts in the usual ways (using Shift-click or Ctrl-click and/or Shift+Ctrl+click).
e Select one or more groups in the usual way.

2.Right-click and choose Broadcast IM. The Broadcast Instant Message window appears.

3.Type the message including any emoticons and formatting that you wish. To insert a return in the message, press
Enter. (You can control the behaviour of Enter and of Ctrl-Enter on the Softphone > Preferences > Application
panel.)

4.Press Send or Enter. The IM is sent and the window remains open. If a recipient sends you a response, the
response will display in your regular Instant Message window; you will then be in a regular IM exchange with that
one individual.

Sending a Broadcast IM to 'everyone’
You can send a broadcast IM to everyone in the system using the 'everyone' contact located under the "Broadcast
Groups" group.

1.In the Contacts tab, right-click 'everyone' and select Send Instant Message.
2.Type your message and press Send or Enter. The message is sent to all contacts in the system group.

Alternatively, you can use the process outlined in "Sending a Broadcast IM" to right-click on the system group and send a
broadcast IM to all the users in the system. The difference is that you have the option to selectively remove individual
users, which is not possible with the 'everyone' broadcast method.

When you receive a broadcast message from 'everyone,' the sender is indicated in square brackets but you will not be
able to reply. Any attempt to reply is met with the error message "Replies to broadcast messages are not allowed."

Group Chat (ad-hoc conference IM)
Softphone's ad-hoc Group Chat feature allows you to exchange instant messages with a group of people in a session that
is created on the fly (to participate in a chat session that is not ad-hoc, see Chat Rooms below).

All people in a group chat must have XMPP accounts configured in order to participate in the session. There is no limit to
the number of participants in a group chat session, and you can invite more participants during the session.

1.In the Contacts tab, select the desired online contacts.
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2.Right-click the last selected contact and choose Start Group Chat. The invitation dialog appears.
3. Enter your invitation text and click Invite.

4.To invite additional participants to a group chat, select online contacts (who have XMPP addresses) from your
Contact List and drag them to the Group Chat window. Any participant in the group chat can invite more
participants.

Note: You cannot start a group chat with the 'everyone' contact because it is a special user. If you right click
'everyone' and select Start Group Chat, nothing will happen.

Leaving a Group Chat
To leave an ad-hoc group chat, close the Group Chat window. The session continues with the remaining participants. You
will not be able to rejoin an ad-hoc group chat unless you are re-invited.

Chat Rooms

Chat rooms are set up to allow the same groups of people to have regular and recurring group IM sessions. For example,
your system administrator may create a chat room called "Marketing" and add the marketing staff as members. Every
Monday at 8:00 a.m., each member opens the chat room on the IP Office Softphone and joins the "Marketing"
conference.

Joining a Chat Room
Chat rooms are unlike group chat sessions in that they are not ad-hoc. So, unlike group chat sessions, you are able to
view a list of available chat rooms via the View menu.

1. Obtain the names of the chat rooms you wish to enter from your system administrator.

2. Select View > Chat Rooms. If the menu item does not display, make sure that the appropriate XMPP account is
enabled. If you have more than one XMPP account, an account prompt appears.

3. Select the appropriate account and click OK. The group chat appears on this list until the last person leaves.

4. Select the chat room and click Join Conference. The Chat Room
window displays, listing the participants who have joined the chat room session.

Rejoining a Chat Room
If you leave a chat room, you can rejoin it using the procedure above.

Viewing the IM Message Archive
You can view your recent IM activity for any contact, group chat session, or chat room session. Do one of the following:
e On the menu, click View > Message Archive.
e Select your own name to view your group chat and chat room sessions.
e Select another person to view instant message exchanges with that person.

e Select one or more names and then right-click to save or delete all conversations with the selected
people.

e Select a conversation and right-click to delete or save the selected conversation.
e Right-click a contact and choose View Message Archive.
Sending and Receiving Files

If you have an XMPP account, you can send files to another contact who has also has an XMPP account. You can also
receive files from a contact who has an XMPP account.

Sending Files
Choose one of the following options:

¢ Right-click a contact and choose Send Files. A standard Open dialog box displays. Select the files to send and
click Open. The Send Files dialog displays a status message to show the progress of the file transfer.

e Drag a file from a folder to the IM window.
To cancel the file transfer before the other person retrieves the files, click Cancel.
Receiving Files
When you receive files from another person, a File Transfer dialog box displays. Choose one of the following options:

e Click Save to accept the file transfer and select the location where you want to save the file.
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e Click Decline if you do not want to receive the file transfer.
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3. Dialing Tabs

There are a set of tabs that can be displayed either as part of the main IP Office Softphone display, or as separate
floating windows.

The tabs are:

« Contacts/2®
A directory of contacts stored by IP Office Softphone.

« History/2™
Details of your calls made, received and missed while IP Office Softphone is running.

 Directory/ 2™
A directory of contacts supplied by the IP Office telephone system.

o Features[2$
A set of clickable buttons (up to 30) each of which can be assigned to a specific IP Office feature.

« Speed Diall3%
A set of clickable buttons (up to 60) which can be used to fast dial preset nhumbers.

Detaching a Tab
1. Select the tab.
2.Click on the [T icon. The tab is changed to be a separate floating window which you can move, resize and position

separately from the main IP Office Softphone window.

Reattaching a Tab
1.Click on the I icon at the top right of the floating window.

Showing/Hiding the Tabs
The set of tabs can be hidden when not required. This option affects all the tabs and includes tabs that have been
detached.

e To change the current status (shown or hidden), select View and then choose one of the following options: Show
Contacts, Show History, Show Directory, Show Features, or Show Speed Dial.

3.1 Contacts Tab

The Contacts tab displays your contacts and lets you specify multiple contact methods for them, including:
e Softphone address
¢ Home phone number, business phone number, mobile phone number.

Contacts are typically organized into groups. The IP Office Softphone includes built-in groups: Broadcast Groups, Family,
Friends, system, and Work. You can add more groups by specifying a new group name when you add or edit a contact.

From the Contacts tab, you can perform the following actions:
. &]’ Add a contact
Select this option to add a new contact.

e View Details of a Contact
Click on a contact to view the full details of that contact and select to see your call history filtered around calls to
or from the contact or select to edit the contact.

e Call a Contact
Double-click on the contact to make a call.

o W
When the contacts are shown in their groups, you can use the = arrow icon next to each group to expand or
collapse that group.

You can also right-click on a contact to select additional options for that contact. The following options are available:
e Call
e Video Call
e Send Instant Message
e  Start Group Chat
e Send Files
e Edit a Contact

e View Call history
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e View Message Archive
e Add to Alert List

e  Split Contact

e Delete Contact

Note: The contacts are not identical to the personnel directory on IP Office. Access to IP Office personnel directory on
softphone is possible through the Directoryl 27 tab but it is not possible, to edit this directory from IP Office. However, if
used in application mode with one-X Portal for IP Office as the front end, full editing of personal directory is possible.

3.1.1 Managing Contacts and Groups
3.1.1.1 Adding a Contact

Click &}' or right-click a group and choose Add Contact to Group. The Contact Profile dialog appears.

Brofile

e = . .
[“ Group: l Family - I

& contact *
|. Softphens = | [.. N
% A e
."-' |
*Dizplay namsa: |\| )
Last name: |'f ."l
e o
e .\
First name: | |
|- H Cancel |
L i
Field Description
Contact Only the "Display name" is required. This is the name that will appear in the call panel and the Call

Alert when this person phones you.

You can specify the contact method on the right side of the screen. Select a method from the
drop-down menu and enter the contact information. You must enter at least one contact method.
Enter as many contact methods as you want. Softphone entries and e-mail entries must have the
format <name>@<domain>.

Group Click to show the list of groups and check each group to add this contact to.
Primary This field displays only when the contact has more than one Softphone number or Instant Message
presence address. The primary presence is used as follows:

e The presence icon on the contact list shows the online status for this address.
e The single-click and double-click actions for instant messaging use this address.

You can still send IMs to this person at their other addresses, but you must right-click and choose
from the context menu.

Primary phone If the contact has more than one number, select the primary number. This number is used with
number single-click and double-click calling.
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3.1.1.2 Adding a Contact using an Existing Address
1.You can add a contact by capturing existing information:

e If you are on a phone call with a person who is not a contact, click the Add to Contacts button in the call
panel.

e On the History tab, select an entry that is not a contact. Right-click and choose Add as Contact.
2.The Contact Profile dialog appears. Complete the dialog as desired and press OK.

3.1.1.3 Importing Contacts

You can populate the IP Office Softphone contact list by importing from an external file or files. The new contacts will be
added to the existing contacts.

You can import a contact list from:

e A comma-separated file. Use this method to import from a Microsoft Excel file. You will first have to set up the file;
see below.

e A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an e-mail.

1.From the main menu, click the Contacts menu and choose Import Contacts. The Import Contacts wizard
starts.

2.As soon as you click Finish on the wizard, the Contacts tab in the IP Office Softphone is updated to show the
imported entries.

Setting up an Excel File for Import

1.Remove any introductory text or headings from the top of the file. (You can keep text at the end of the file; it will
be ignored during the import.)

2.Insert a blank row as the first row, then insert the headings that the IP Office Softphone will use to interpret the
meaning of each column. The columns can be in any order. The most popular headings are:

e display-name

e entry_id

e given_name

e surname

e postal_address
3.Save the file as *.csv.

3.1.1.4 Exporting Contacts
You can export a contact list to a comma-separated file or a vcf file.

1.From the main menu, click the Contacts menu and choose Export Contacts. The Export Contacts wizard
starts.

2.When you click Next, the export begins. A new file of the specified type is created.

3.1.1.5 Changing Contact Information
To change the information for a contact, right-click the contact and choose Edit Profile.

3.1.1.6 Moving or Deleting a Contact
e To drag one or more contacts to a different group, select them and drag to the title bar of the new group.

e To delete one or more contacts, select them, right-click, and choose Delete Contact or Delete Selected. The
contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.

Note: The System group is configured on the IP Office server and is populated on your softphone each time that you log
in (and only users with valid XMPP accounts appear in the System group). If you move or delete contacts from the
System group, the contact is restored to the System group when you log in again. To include a contact in a group other
than the System group, right-click the contact and select Edit Profile to display the Contact Profile screen. Select an
additional group from the Group menu and click OK.
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3.1.1.7 Adding, Deleting or Renaming Groups
Select any group, right-click, and choose the appropriate menu item.
3.1.2 Using Contacts
To phone the person: e Double-click the contact to start a phone call
e Right-click and choose Call. If necessary, click the desired number.

e Drag the contact to the call entry field to start a phone call.

Contact Flyout
Click a contact to show the Contact flyout. This flyout shows all the contact methods set up for the contact. You can click
a contact method to perform its action.

o s

Kokila Perera

"y Sofiphone : 2221234

[ Edit Profile | [ Call History |
e

3.1.3 Using My Buddy

My Buddy is a notification and command interface that can be used in conjunction with any XMPP-based messaging client.
The user ‘mybuddy’ should appear in your System contacts list and will assist you with many softphone tasks.

To view the commands available through My Buddy
1.Begin an IM session with ‘mybuddy’ (right-click, Start Group Chat).

2.In the IM window, type ‘help’ and press Enter.
My Buddy replies with a list of available commands. To view information about each command, type ‘*help’ followed
by the command name and press Enter.

To enable a particular command
1.Begin an IM session with ‘mybuddy.’

2.1In the IM window, type the command name, followed by the name or extension of the person you wish to perform
the command on, and press Enter. Some commands will work on their own, but other factors might be
extenuating (for example, the command ‘lock’ requires you to be hosting a conference).

3.1.4 Sharing Online Status

You can publish your online status to contacts who have a softphone address, and you can set up the IP Office Softphone
to view the online status of other contacts.

Watching the Status of Others
To watch a contact’s status, that contact must be tagged for presence:

o If you create a contact through the Contact Profile, the softphone automatically obtains status information if
the contact has a valid XMPP address.

e If you create a contacts through the Contact Profile and you include an XMPP address, you can click the
Enable XMPP Presence button to obtain status information for this address.

o If you create contacts by importing a contact list, you can specify during the import whether you want to
share presence information. See Importing Contacts[ 24",
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Setting your status

Click the down arrow beside the online status indicator on the IP Office Softphone, and select the desired online status.
The table below lists the status indicators.

Indicator

Meaning for your Status

Meaning for Status of Others

9 Available

Either:
e You have set your status to this value.

e The softphone has determined that you
are logged on but not on the phone or
idle.

When you have this status, the softphone
will automatically detect when you are idle
or on the phone, and change the status to
match. For more information about the
On the Phone or Idle statuses, see the
descriptions below.

You can contact this person.

a Busy

You have set your status to this value.
the softphone does not automatically
switch you out of this status; you must
switch yourself.

You can contact this person.

@ Away

You have set your status to this value.
The softphone does not automatically
switch you out of this status; you must
switch yourself.

You can contact this person.

On the phone

Either:

e You have set your status to this value.
In this case, the softphone will never
automatically switch you out of this
status; you must switch yourself.

e You started a phone call when your
status was “Available”. When your call
finishes, your status reverts to
“Available”.

You can contact this person.

a Not available for calls

You have set your status to this value.
The softphone does not automatically
switch you out of this status; you must
switch yourself.

You can contact this person, but do not expect
a reply.

a Do not disturb

You have set your status to this value.
The softphone does not automatically
switch you out of this status; you must
switch yourself.

You can call this person, but you cannot send
IMs.

@ Idle

You cannot select this status. This status
displays automatically if you have not
moved or clicked the mouse or pressed a
keyboard key for the Idle period. To set
the Idle period see Softphone >
Preferences > Application.

As soon as you click the mouse or
keyboard, your status changes to
“Available”.

You can contact this person.

@ Appear offline

You have set your status to this value.
The other person sees you as offline, even
though you are actually online. The other
person cannot tell the difference between
this status and you really being offline.

The contact is either not logged on or does not
want to share online status.

No icon

Not applicable

You are not watching the other person’s status.
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Customizing your status
You can create a custom status indicator.

1.Click the down arrow beside the status indicator, and double-click on one of the existing indicators.

2.Type your custom status.

Adding Contacts to the Alert List
You can add a contact to the Alert List in order to request to be notified when the online status of a contact changes.

Right-click the contact or contacts and choose Add to Alert List. The Alert List icon appears beside the contact.
When the contact’s status changes, a notification displays. Choose one of the following options:
e Click the phone icon or the IM icon on the notification window to call or IM the contact.

e Select the Keep contact on Alert List checkbox to continue receiving notifications of status changes for this
contact. If you do not select the checkbox, you will not receive further notifications.

3.2 History Tab

The History tab shows a record of calls that have occurred while IP Office Softphone is running.
Click on the = icon to select the type of call records to display in the call history.

o All
All calls of the various types listed below.

=
« = Received
Incoming calls that you have answered using IP Office Softphone.

=
+ % Dialed
Outgoing calls you have made using IP Office Softphone.
=
« %) Missed
Incoming calls that have alerted your IP Office Softphone but were not answered using IP Office Softphone.

e The Eﬁ icon appears in the main IP Office Softphone window to show when there are missed calls in the call
history. It also shows the number of missed calls. Clicking on the icon will display the History tab.

Managing the Lists of Calls
You can right-click on an entry in a list to:
« Call
+ Video Call
¢ Add as Contact
o Delete

o Delete All Calls

Phoning from History
You can:

e Right-click on an entry to place a call to this person, using the contact method that was used for this call.
e You can double-click to place an audio call.

e Place a call to this person and add them to a conference call that is in progress.

Note: Contacts are only recorded when the softphone is running. Calls received when the softphone is not active will not
be shown.

If IP Office Softphone is used in combination with one-X Portal for IP Office as the front end, the call log functionality of
one-X Portal for IP Office can be used that will record all incoming calls including those received when the softphone is
not active.

3.3 The Directory Tab

The Directory tab links directly to your local IP Office. Your directory will contain contact entries from the following IP
Office contact stores: local IP Office directory, local IP Office Small Community network numbers, Local & IP Office Small
Community Network Hunt Groups, Private user Directory.
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Search for a Contact

The search box is context sensitive and allows you to search by name or by number. Start typing in the search box and
the displayed list of contacts will automatically start to narrow down based on your input.

You can clear the Search Box by clicking the 'X’ displayed at the far right of the Search Box.

i ——

(4 X)
MName Mumiber

AndyA 3452

Carol Walker (416)555-9903

Claire Thomas (613)055-0429

Frank Chan fchan@domaind_com

Jean Thibeault jthibeault@domains com

Jozeph Santos jsantos@DomainA. com
Kevin Agarsal (604)555-1837

Kokila Perera kperera@domaind. com
MattR 5453

Maurice Dale (604)555-1219

Matalia Dwvorak ndvoraki@domainA. com

Phone a Person

You can phone a person directly from the Directory. Right-click a directory entry and choose Call or Video Call. A new
call panel will appear and the call is placed immediately.

(ke X)

Name = Mumber
Carol Walker (416)555-9903
Kevin )555-1837

Call
\ideo Call

Add as Contact

Create a Contact

Right-click an entry and choose Add as Contact. The contact profile window appears, populated with all the information
from the IP Office directories.

Complete the window with any missing information that you want to record and press OK. The contact will now be listed
on your Contact tab.
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Video Cail

Jean Thibeault |
Add as Contact

Joseph Santos
Kokila Perera

Maurice Dale (604)555-1219

Note

kpererai@domains. com

(c X)
s

Mame = Mumber

Carol Walker (416)555-9903

Claire Thomas

Frank Chan cal omaind com

ti@domain.com
Dromaind. com

While it is possible to access the centralized private directory on IP Office, it is not possible to change the directory on IP
Office from IP Office Softphone. Please change it from your desktop phone or one-X Portal for IP Office .

3.4 Features Tab

The Features tab allows you to access a set of button which can be used to control various IP Office call features.

( con | ( Fwuon ) ( Fwuor |
(_ onpon | ( onpor | ( wwmon ]
( Fwaor | [ Here+ | [ Fato |
[onox- | ] )

Configuring a Feature Button

1.To configure a button, right-click on the button and select Edit. A menu with the button options appears.

" Edit feature button x

Choose a feature to assign fo this button:

@ Predefined {:} Customn

Feature: |conerenceacs v]

Button Label: | :I

Feature Code: | )

- Aszign Canc i
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2.To use one of the existing IP Office features, select Predefined and select the required feature from the drop

down feature list.

Choose a feature to assign to this button:

@I Predefined C‘ Custom

Feature: [CnnferenneAdd

|

Bution Label: |

Feature Code: |

Conferencesdd
CanceAllForaarding
ForwardUnconditionalOn
ForwardUnconditional Off
ForwardOnBusyOn
ForwvardOnBusy Off
ForwardOnMoAnzwerCn
ForwardOnMoAnswerOff

A

3.To use a custom feature, select Custom. Enter the label and feature code manually.

4.Click Assign.

To Display More Buttons
1.Right click on the page and select Show rows.

2.Select the number of rows of buttons to be displayed on the tab.

3.5 Speed Dial Tab

The Speed Dial tab allows you to create a set of buttons for numbers you want to dial in a single click. You can set a
text label for each button, and you can choose whether to view the status of the extensions that you add.

[ John :I I: Home :I I: Sarah :I

| Alison | |
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Configuring a Speed Dial Button
1.To configure a button, right-click on the button and select Edit.

2.Enter a name and number for the contact.

3.1If you select Show status, the button will indicate the busy status of the number if it matches an internal
extension.

When you select Show status, you will see a visual indicator of the status. You can also choose to receive an audio
notification when there is an incoming call to an extension that you are monitoring. This feature is useful if you
need to monitor calls to other extensions and answer them if the user at that extension is not available. For more
information, see Alerts & Sounds/ 3.

4.Click OK.
To Display More Buttons
1.Right click on the page and select Show rows.

2.Select the number of rows of buttons to be displayed on the tab.
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4. Configuring Preferences

Choose Softphone > Preferences. The Preferences window appears. The Preferences panels let you control the way
that you work with the IP Office Softphone.

4.1 Application

This panel lets you set your preferences for general GUI behavior and lets you set up for login.

Preferences

(TApplication | Application

,a.,m & Sounds | ¢ ‘General Preferences

Enimd Languages: [Emglish {Us) ‘F]

Devices

Shortcut Keys [] Launch when Windows starts

Video Codecs E Call immediately once a phone number is selected
Media Cuality [¢#] Display in-call buttons on the dialpad

Call Autormnation f f

Delay automatic login by: I_f tl seconds

a

~ Messages & Prezence

i
E Display idle status if | don't use my computer for: f 10 | minutes

, L

In messaging, pressing Enter will

@ Send the message (Use Cirl + Enter to create a line)
() Create a new line (Use Cirl + Enter to send)

I:l Show timestamp on messages

~ Default Actions
ou can change the default behavior for the buttons and actions below.

Button: | Call V] Default action: [Call v]

Action when double-clicking on contact: [C-a!l - l

Reset 1o Defout (oK ) (Gomeel

s

4.2 Alerts & Sounds

This panel lets you choose how you will be notified of events on your IP Office Softphone.

On the Alerts tab, you can enable a call alert dialog box:

Alerts & Sounds

Application
Aleris & Sounds

Sounds

Privacy aler!dlsplays

Devices

@ For an incoming call
Shortcut Keys |

The call alert box is a small menu that is displayed when an incoming call arrives.
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Pl Kokila
£ W Kokila

It.. Answer] lﬂ DE{‘.liI'IE]

You can use the Sounds tab to also enable audio notifications for different call scenarios. These notifications can be a
default sounds provided by IP Office Softphone, or you can select a sound file that you want used for each scenario:

" Preferences - X
Application Alerts & Sounds
Alsrts & Sounds Alerts | Sounds |
Privacy [#] Enable sounds
Devices
Shorteut Keys [#) For an incoming call
Video Codecs
Vides Lodees E For call waiting
Media Quality

f# For auto answer

f#] For hangup

[#) For an incoming 1M

Call Automation

E When a contact comes online
[# When a contact goes offline

IE For incoming call on monitored endpoint in Workgroup

E For incoming call on monitored endpaint in Workgroup(busy)

Sound preference: { | [:]
(Erowse.. ) (Reset]

-

You can also choose to receive an audio notification when there is an incoming call to an extension that you are
monitoring. This feature is useful if you need to monitor calls to other extensions and answer them if the user at that
extension is not available. The options are:

Select For incoming call on a monitored endpoint in Workgroup to receive an audio notification when there is an
incoming call to an extension that you are monitoring. Select For incoming call on a monitored endpoint in
Workgroup (busy) to receive an audio notification when there is an incoming call to an extension that you are
monitoring while you are in a call.

You can monitor an extension by configuring it on a speed dial button and selecting Show Status. For information about
how to configure a speed dial button, see Speed Dial Tab[ 30,

4.3 Devices

The IP Office Softphone automatically detects devices at each startup and selects the most appropriate device for each
purpose. If you do not like this selection, you can override it on this panel. If you override a selection, it will apply the
next time you start the softphone, unless the device is no longer available, in which case the softphone will again
automatically select the device to use.

When Zero-touch device configuration is enabled, the Softphone will automatically detect the new device and start
using it whenever you change your audio or video device.
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Preferences

. Application .
Alerts & Sounds:
Privacy

Devices

fo#] Zero-touch device configuration
fof| Alsa ring PC speaker

Snonc:t Keys
‘Video Codets
Media Quality
Call Autocmation

Resat b Default

—

[ Test Devices

Headset Made [ Speakerphone Mode | Other Devices |

Speaker [ Conexant HD Audio ocutput b |

Microphone: l Conexant HD Audio capture hd |

HIDDwme[Nuns v’” ]

Preferences

| appliestion |
Alens & Sounds
Privacy
Devices
Shorcul Keys
ideo Codets
Media Quality
Call Automation

Resel bo Default

—

Devices

] Zeno-touch device configuration

j#] Also ring PC speaker

| Test Devicas

[ Headset Mode || Speakerphone Mode ]ﬁtm
Ring on | Conexant HD Audio output v]
Camera | Integrated Camera v]

(o) (ooa]

—

However, if you have more than one device available at the same time and you wish to change from one device to
another, you will need to do the following:

1.Restart the application.

2.Go to Softphone > Preferences and select the desired headset/speakerphone under the Devices tab.

3.Go to Help > Troubleshoot and select the audio device you wish to use under the Devices tab.

4. Restart the application.

If you continue to have problems, disable Zero-touch device configuration and try the procedure again.
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Configuring Preferences: Devices

4.3.1 HID Devices: USB Device Button Setup

You can assign functions to a HID-compliant device. For example, you can set the green button so that it answers an
incoming call.

B De Bution Sef

C-Media USB Headphone Set

1. Select a call action {e.g. Answer).

2. Enter a description of the bution you are mapping (2.9. Green button).

)

3. On the USB device, click the button you are mapping (e.g. Click the green button).

Button mapping: { | | |

| Call Action Device Button |

[ Remove |

- OK | [Cancel |

4.4 Shortcut Keys

This menu allows you to select whether you want to use shortcut key combinations for certain actions and to edit what
those key combinations are.

Drafo

Applicstion Siidis Ll
Aleris & Sounds Assign global keyboard shortcuts to frequently used functions
Privacy E = N
Devices — = —
Enable | Action Key Combination
Shortcut Keys
E Answer call CTRL + SHIFT + ALT + A
“ideo Codecs
Media Quality @ Hang up call CTRL + SHIFT + ALT + H
Call Automation @ Focus Softphone CTRL + SHIFT + ALT + F
@ Toggle mute CTRL+SHIFT +ALT = M
@ Redial CTRL =+ SHIFT + ALT + R
(Edit...|

4.5 Video Codecs

Video codecs describe the format by which video streams are compressed for transmission over networks. Some codecs
require less bandwidth than others, but may result in lower video quality. Change the settings on this tab only if advised
to do so by your system administrator.
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Preferences

Applicstion
Aleris & Sounds
Privacy
Devices
Shortcut Keys
\ideo Codecs
Wedia Quality

Call Automation

Select a codet from the above lists fo view properiies

Video Codecs

Available Codecs ) Enabled Codecs

H.263+ (1808) - H.263

H.264 (unified)
-

=

BE)

Description: H.263

CPU usage: _
ity | |

Low High

With only one codec enabled, all calls made will use that particular compression format. With more than one codec
enabled, the IP Office Softphone automatically chooses the best codec based on the other party’s capability, the available
bandwidth, and network conditions.

Note that it is not possible to set a 'preferred' video codec, nor does IP Office negotiate one.

4.6 Media Quality

These settings are used to adjust the IP Office Softphones video and audio operation.

Application
Aleris & Sounds
Privacy

Devices
Shoricut Keys
Video Codecs

Call ﬁut-umstii:n

| Reset to Default

Media Quality

Audio Quality | Video Quality

E Reduce echos from speakers (AEC)
i@ Reduce background noise
k# Automatic gain control

7~ Volume Control

Al Sofiphone to controd the speaker volume and the
Microsoft Windows® master volume control. Use if you want
the speaker volume fo directly conirol overall volume,

_ Limit mainvum violume of Softphane 1o the Microsoft
WindowsE master setting. Use if you play different audio
devices on your computer.

| Cancel
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Configuring Preferences: Media Quality

Application | Media Quality

Alerts & Sounds @] Video Cuality |

Privacy

Devires a Enable this option if your camera displays video upside-down
Shartcut Keys ~ Resolution

'I‘Fn'
ideo Codece High resolution provides improved quality images necessary for

Media Quality larger displays but requires more network bandwidth.
o Audomaton (] Disable HD video

Reset to Default Cancel

b

4.7 Call Automation

These settings let you configure how you want auto answer to handle incoming calls, when Auto Answer is enabled.

Preferences »

Application Call Automation

Aleris & Sounds Auta Answer Calls 9

Privacy Auto answer after | 3 W | seconds

Devices {Choose 0 fo auto answer immediately)
Shortcut Keys Media when auto answer is on:
Wideo Codecs
Wediz Quality

| Call Automation |

(@ Auto answer with audio

() Auto answer with audio and video

Third-party Call Automation s

Third-party call answer media:

@ Always answer with audio-only

O Anzwer with video if incoming call is a video call

e Auto Answer Calls

Use the settings in the Auto Answer Calls area when you have selected auto answerl 18" in the IP Office
Softphone call panel.

e Third-party Call Automation
The Third-party Call Automation feature controls how the softphone handles external auto-answer requests.
Ensure that this option is set to Auto-answer with audio-only.
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Q
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Resume 14
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S
Show 12
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T
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Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of
information in this document does not imply freedom from patent or other
protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered
to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their
respective owners.

This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to
"wgctechpubs@avaya.com".

© 2011 Avaya Inc. All rights reserved.
Avaya

Unit 1, Sterling Court

15 - 21 Mundells

Welwyn Garden City

Hertfordshire

AL7 1LZ

England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933

Web: http://marketingtools.avaya.com/knowledgebase
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